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Copy Shop Sales Order  

Case Study 
 
 
As an accounting software installer, I’ve learned from experience that most businesses can pick 
blindly from among the top accounting systems in the world and pretty much get the job done. 
From one business to the next, accounts payable needs, payroll needs, trial balance needs, 
reporting needs, and even inventory needs are similar and well covered by today’s top 
accounting systems. However, there is one area which differs dramatically  - and that area is in 
the sales order. It turns out that each company sells differing kinds of products and services 
with options so varied, that few accounting systems are prepared to handle those needs. In this 
situation, I make a bold claim that an Excel template can be easily used to fill in the missing 
gaps and supplement any accounting software system to provide excellent order taking 
capabilities. 
 
  



www.CarltonCollins.com Page 3 Copyright April 2011 
 

In this case study, let us assume that we are working with a small copy shop – a small family 
owned company with about $300,000 in revenue. In this case they have determined that 
QuickBooks meets all of there needs, except for order taking. Therefore our goal will be to build  
a Sales Order system using Excel in only a few minutes. Listed below are the key elements that 
you will learn in this case study: 
 

1. Neat and Organized Worksheet Design 
2. =NOW() 
3. Data Validation Lists 
4. =VLOOKUP 
5. Creating Macro Buttons 
6. Creating Macros 
7. Relative versus Absolute Macros 
8. Worksheet Protection 

 
Think about a copy shop for a minute, what is so difficult about taking an order in a copy shop? 
It is the options. How many copies would you like? Do you want that printed on front and back? 
Stapled or Bound? What kind of binding? What size paper? What color paper? What pound 
paper? Do you want regular or fast delivery? These are all standard questions asked by a copy 
shop, yet QuickBooks, nor any high end accounting system is able to take such an order. Even 
the million dollar solutions aren’t equipped to take such an order. These companies must 
instead resort to purchasing a software application called a “product configurator”, solutions 
which can costs $75,000 to $750,000 or more. To make matters more difficult, there are often 
rules associated with various options – for example, when ordering a car, if you order the sun 
roof option, you can not also order the T-Top option. Product configurators must account for 
and accommoate these types of situations. 
 
1. Let us begin by simply labeling our sales 

order form. As you can see in the screen 
to the right, we’ve added some labels and 
highlighted some data input fields with 
yellow background and gridline borders.  

 
(For purposes of this case study, we will 
only build in options for color and size, 
but once you get the hang of it, adding in 
additional options for paper weight, 
binding, duplex printing, etc is a rather 
simple matter.) 
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2. =NOW() – Next we type in the Excel Function =NOW(). This will cause Excel to display 
the computer’s date and time each time an order is produced. You can see the =NOW() 
function in the formula bar and the results displayed in cell B2 below. 
 

 
 

3. Calculations for Base Rate – Next we add simple calculations to multiply the total 
number of pages to be copied by the total number of copies and the base rate per copy. 
To make it easier to visualize, I have added some customer data. (The formula contained 
in cell B11 is displayed in the formula bar.)  
 

 
 

4. Color Options – Next I created a table of the color options along with a sur-charge rate per page 
for each color. Notice that there is a “zero” sur-charge when selecting white paper. Make sure 
to sort your table in descending order because we plan to refer to that table via a Lookup 
function – and as we all know, lookup functions do not work properly unless the table array is 
sorted in descending order. To make the table of options more readable, I applied gridlines and 
a greenish background.  
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5. Data List Validation – Now this is where the excitement begins. Next I create a data validation 
list in cell B13 using column one of my options table. To do this, select B13, and choose Data 
validation from the Data Ribbon. Next select List and use the Cell Chooser to highlight the 
options in column one of your color options table.  
 

   
 

 
 

6. =VLOOKUP – Next I inserted a =VLOOKUP function in cell B14 to return the Sur-Charge rate 
based on the Color Selected. 
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Notice that when you select different colors in cell B13, the rate in Cell B14 changes according to 

the Color Option table. 

 

7. Size Options - Repeat steps 4,5 & 6 above to also create Size Options.  

 

 
 

8. Invoice Total – From here it is an easy step to add calculations to total the invoice. Of course 
your complete invoice would also include sales tax calculations as well. Our example is kept as 
simple as possible to make sure that the key points come across as easy as possible. Here’s what 
we have so far: 
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9. Macro Buttons – To make the Sales Order form easier to use, next we will add three macro 

buttons. We start this process by creating a single text box, and using the Drawing Tools to make 
it look fancy. Here are steps: 
 

      

 
10. Create the Print Macro – Next create a print macro by selecting “Macro, Record Macro” from 

the “View Ribbon” (make sure that no spaces are used in your macro name and save the macro 
to “This Workbook). Set the “Print Area” appropriately to display your Sales Order Form. Next 
simply highlight your Sales Order Form and print three copies, then stop recording your macro 
by selecting “Macro, Stop Recording” from the “View Ribbon”. Once completed assign the 
Macro to the Print Sales Order Button by right mouse clicking and selecting “Assign Macro”.   
The right click menu as well as the Assign macro Dialog box are shown in the two screens below. 
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You want to print three copies of the Sales Order as follows: One for your customer’s 
records; One for your product people to follow when making the copies, and one for 
bookkeeper to use when entering the invoice amount into QuickBooks.  

 
11. Additional Macro Buttons – Next right click on the edge of the existing macro button 

twice, and choose “Copy”; then click away from the button and Paste twice. This will 
create two exact copies of your macro button. (You must right click twice on the edge of 
the button to display the second menu of options.)  

 

 
 

Next select the “Select Objects” menu option from the “Home” Ribbon’s “Find and 
Select” menu in the “Edit” Group. Then lasso the three buttons and from the “Drawing 
Tools”, use the Alignment tools to left justify and Distribute Vertically the three buttons. 
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The results will appear as follows: 

 

 
 

Press escape to deselect the “Object Pointer” tool, and return your cursor to normal. 
 

12. Post Sales Order Macro Button – Next I created a macro to post the sales order information to a 
database. This is complicated and I will demonstrate several teaching points in class to help you 
fully understand the process of writing a combination relative and absolute Here are the steps: 
 

a. Relabel the second Macro Button to Read “Post Sales Order”. This will require you to 
first right mouse click on the button and select the text, or if you prefer, remove the 
macro before continuing.  

b. Highlight cells B2 thru B21 and label that range “salesorderdata” using the Name Box. 
c. Go to Cell H1 and enter the phrase “Database” in cell H1. 
d. Label cell H1 “database” using the Name Box. 
e. Copy the labels in cells A2 thru A21 and Paste Transpose them to cell H2. 
f. Start recording a macro named “postsalesorder”. 
g. Click the “Use Relative References” option from the Macros Group on the View Ribbon. 
h. Press the F5 key to launch the GoTo Dialog Box.  
i. Select the range “salesorderdata” by double clicking on the word “salesorderdata”. 
j. With your cursor hovering above the selected range, right mouse click and choose 

“Copy”. 
k. Press the F5 key to launch the GoTo Dialog Box.  
l. Select the range “database” by double clicking on the word “database”. 
m. Press the End key, followed by the Down Arrow. (You will now be on the last row.) 
n. Press the Down Arrow. (You will now be on a blank row underneath the last row.) 
o. With your cursor hovering above the selected range, right mouse click and choose 

“Paste Special”. 
p. In the paste Special Dialog Box, check Values and Check Transpose, and click OK. 
q. Place your cursor on cell A1. 
r. Stop recording the macro by selecting “Macro, Stop Recording” from the “View Ribbon. 
s. Assign the newly recorded macro to the Post Sales order macro Button. 
t. Select Column H and format it to display Time and Date. 
u. Adjust the width of your database columns to your preference. 

 
13. New Sales Order Macro Button – Finally, edit the Third macro Button to Read “New sales 

Order” and create a macro that selects the yellow background data cells and deletes the 
contents. (Make sure to toggle the “Use Relative References” option off because this macro 
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needs to be an absolute macro.) (Also make sure to select Cell B4, then hold the CTRL key down 
while you also select the other yellow back ground cells). Before you Stop Recording this macro, 
click on cell B4 so your cursor will be in the correct place to start recording a new sales order. 

 

 
 

14. Testing – Test your three macros by filling in new sales order information, then click the three 
macro buttons in sequence to print, post and delete your data. 
 

15. Unlock Data Input Cells – Next, select the cells containing the yellow background and also select 
the database columns (Hold the CTRL key down to make multiple selections. Then format the 
those cells to unlock them by right mouse clicking atop your selection and selecting “Format 
Cells, and unchecking the Locked Box on the protection tab – as shown below: 
 

 
 

16. Protect Your Worksheet - Finally turn on worksheet protection by selecting “Protect Sheet” 
from the Review ribbon. Enter a password and repeat the password. This will prevent you or 
others from making accidental changes to the formulas and data contained in your template. 
 

17. Keep in Mind – This case study covered the basics, but you could enhance this template a 
number of ways. Here are a few example hints: 
 

a. Combine the three macro buttons into one button that performs all tasks – printing, 
posting, and deleting. 



www.CarltonCollins.com Page 11 Copyright April 2011 
 

b. You might add an invoice number to the top of the page. Each time you post, your 
macro might also create a temporary formula in an empty cell that refers to the invoice 
number and adds one, then copies pastes that result atop the invoice number cell using 
the paste value command. Make sure the macro then deletes the formula in the 
temporary cell. 

c. You could easily add more options to your order form.  
d. Notice that we also included an option to decrease our price if a smaller paper size is 

selected.  
e. The sales order form could be dressed up to look far more professional. Colors, grids, 

logos, etc. could all be added to make the sales order form match the accounting 
system, for example. 

f. You could copy the worksheet and edit a second order for to be used in different 
situations. For example, Worksheet A might contain an order form that charges regular 
rates when a regular customer enters the store, and Worksheet B could charge higher 
rates when a lawyer enters the store – and so on. 

g. The resulting database will continue to compile each sales order as posted, adding new 
orders to the bottom of the database area each time you post. 

h. The bookkeeper need only record the date, customer name, address, and total amount  
due in QuickBooks. The printed Sales Order copies on file will serve as supporting 
documentation. 

i. You can download a copy of this example template from www.CarltonCollins.com – click 
the Excel Link. 

 
 

 
 

http://www.carltoncollins.com/
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MACROS 
Automating Your Key Strokes  
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Macros 

  
Macros offer a powerful and flexible way to extend the features of Excel. They allow the 
automation of repetitive tasks such as printing, formatting, configuring, or otherwise 
manipulating data in Excel. In its’ simplest form, a macro is a recording of your keystrokes. 
While macros represent one of the stronger features found in Excel, they are rather easy to 
create and use. There are six major points that I like to make about macros as follows.  
  

Six Major Points for Creating Macros 
 

1.      Record, Use Excel, Stop Recording – To create a macro, simply turn on the macro 
recorder, use Excel as you normally do, then turn off the recorder. Presto – you have 
created a macro. While the process is simple from the user’s point of view, underneath 
the covers Excel creates a Visual Basic subroutine using sophisticated Visual Basic 
programming commands.   
  

2.      Macro Location – Macros can be stored in either of two locations, as follows: 
  

a.      The workbook you are using, or  
b.      Your Personal Macro Workbook (which by default is hidden from view) 

  
If your macro applies to all workbooks, then store it in the Personal Macro Workbook so 
it will always be available in all of your Excel workbooks; otherwise store it in your 
current workbook. A macro stored in your current workbook will be embedded and 
included in the workbook, even if you e-mail the workbook to another user.  
  

3.      Assign your Macro to an Icon, Text or a Button – To make it easy to run your macro, 
you should assign it to a toolbar icon so it will always be available no matter which 
workbooks you have open. If the macro applies only to your current workbook, then 
assign it to Text or a macro Button so it will be quickly available in your current 
workbook. 
  

4.      Absolute versus Relative Macros – An “Absolute” macro will always affect the same 
cells each time whereas a “Relative” macro will affect those cells relative to where your 
cursor is positioned when you invoke the macro. It is crucial that you understand the 
difference. 
  

5.      Editing Macros – Once created, you can view and/or edit your macro using the View 
Macros option. This will open the macro subroutine in a Visual basic programming 
window and provide you with a plethora of VB tools. 
  

6.      Advanced Visual Basic Programming – For the truly ambitious CPA, in the Visual Basic 
Programming window, you have the necessary tools you need to build very 
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sophisticated macros with dialog boxes, drop down menu options, check boxes, radio 
buttons – the whole works. I invite you to knock yourself out. To see all of this power, 
turn on the “Developer Tab” in “Excel Options” (see below).  

  
Presented below are more detailed comments and step-by-step instructions for creating and 
invoking macros, followed by some example macros.  
 

Steps for Creating A Macro 
  
1. Launch Macro Recorder - Select Record Macros on the View tab, or in the Code Group on 

the Developer Tab. 
 

2. Macro Name - Enter a name for the macro In the Macro Name box. 
 

a. The first character of the macro name must be a letter.  
b. Subsequent characters can be letters, numbers, or underscore characters.  
c. Spaces cannot be used in a macro name (an underscore character is often used as a 

word separator.  
d. If you use a macro name that is also a cell reference, you may get an error message 

that the macro name is not valid. 
 

3. Shortcut – (This is optional) Assign a CTRL key combination (such as CTRL+A to run the 
macro by typing any lowercase letter or uppercase letter that you want to use in the 
Shortcut key box. 

 

a. The shortcut key will override any equivalent default Excel shortcut key while the 
workbook that contains the macro is open.  

  
4. Macro Location - In the Store Macro In dropdown box, select the workbook where you 

want to store the macro.  
 

a. If you want a macro to be available in all Excel workbooks, select Personal Macro 
Workbook. When you select Personal Macro Workbook, Excel creates a hidden 
personal macro workbook (Personal.xlsb) if it does not already exist, and saves the 
macro in this workbook.  
 

i. In Windows Vista, this workbook is saved in the 
C:\Users\username\AppData\Local\Microsoft\Excel\XLStart folder.  

ii. In Microsoft Windows XP, this workbook is saved in the C:\Documents andSettings\user 
name\Application Data\Microsoft\Excel\XLStart folder.  

iii. Workbooks in the XLStart folder are opened automatically whenever Excel starts.  

b. Note - If you want the macro in the personal macro workbook to be run 
automatically in another workbook, you must also save that workbook in the XLStart 
folder so that both workbooks are opened when Excel starts. 

javascript:AppendPopup(this,'ofShortcutKey_3_3')
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5. Macro Description - In the Description box, type a description of the macro.  

  
6. Start Recording - Click OK to start recording.  
  
7. Start Typing - Perform the actions that you want to record. New in Excel 2010, macros can 

now record the manipulation of objects, such as inserting or moving a text box.  
  

8. Stop Recording – When you are done click “Stop Recording” in the “Code Group” On the 
“Developer Tab”. You can also click Stop Recording on the left side of the status bar. 

  
9. Assign the Macro to an Object, Graphic in the Worksheet – Insert an object (like a Star 

shape or text box) or graphic image (like a picture) in your worksheet, then right-click on 
that object or graphic image and select Assign Macro from the popup menu. In the Macro 
Name box, select the macro that you want to assign to that object or graphic image and 
click OK. 

 

10. Menu Navigation Not Recorded – Keep in mind that when you record a macro, the macro 
recorder records all the steps required to complete the actions that you want your macro to 
perform. Navigation on the Ribbon is not included in the recorded steps, only the 
commands that are executed are recorded in the macro. 

 

11. Turn On The Developer Tab – By default, the Developer tab is turned off, but you can turn 
it on in Excel 2010 by clicking the File tab select Options, Customize the Ribbon, and check 
the checkbox next to Developer Tab.  In Excel 2007, click the Microsoft Office Start Button 
in Excel 2007, select Excel Options, and under the Popular category, Top options for 
working with Excel, select the Show Developer tab in the Ribbon check box, and then click 
OK. 

 

12. Enable Macros – If the macro functions are disabled, you can enable them by selecting 
Macro Security in the Code group on the Developer tab as shown below. 

  

 
  
Under Macro Settings, click Enable All Macros (this is not recommended by Microsoft 
because potentially dangerous code can then run without your approval), and then click 
OK.  

  
13. Example Macros You Might Find Useful 
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A. Insert Headers and Footers Macro – Start recording a new macro called 

Insert_Headers. Select all of the worksheets, then from the Page Layout tab, double 

click the Page Setup dialog box button to display the Page Setup dialog box. Continue to 

customize the header and footers to include page numbers, date and time stamps, file 

locations, tab names, etc. Assign the macro to an Icon on your toolbar or Quick Access 

Bar for quick and easy access. Thereafter, inserting headers and footers in your 

worksheets will be a breeze. 

 

B. Print Macros – Do you have a workbook containing multiple reports that you frequently 

print? If so, insert macro buttons to print each individual report, a group of reports, and 

even multiple reports, and in the future reporting will be a snap.  

 

C. Delete Data Macro – Do you have a frequently used template that contains a lot of 

variables? If so, create a macro that visits each cell and erases that data, resetting the 

worksheet for use in a new set of criteria. Assign the macro to a macro button and you 

will never again have old assumptions mixed in with your newer template. 

 

D. Macro Case Study – Carlton’s Copy Shop – See the following chapter for a detailed case 

study for using macros.  

  
 
 
 
 

 



www.CarltonCollins.com Page 17 Copyright April 2011 
 

 

 
 

Miscellaneous Tips 
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Excel’s Solver  
 
Solver is one of the more powerful features in Excel because it can solve for optimum results in 
complex worksheets while obeying stated constraints.  With Solver, you can find an optimal 
value for a formula by manipulating a group of cells that are related, either directly or 
indirectly, to the formula in the target cell. Solver adjusts the values in the adjustable cells to 
produce the result you specify from the target cell formula. You can apply constraints to restrict 
the values Solver can use in the model, and the constraints can refer to other cells that affect 
the target cell formula. 
 
In the portfolio example shown below, the user wishes to determine how much money to 
invest in various investments in order to maximize the return on those investments. Of course 
the maximum results can be achieved by simply place in all monies in the investment that yields 
the highest results, however this approach violates the “don’t put all of your eggs in one basket 
rule”. In this case the user wants to diversify their funds across many types of investments. 
Therefore constraints are established such as no more than 35% of funds can be invested in 
blue chip stocks and the checking accounting must contain at least $100,000. 
 
A portfolio is shown below and some constraints have been included in lust form. These 
constraints will need to be stated in terms of formulas in the solver manager dialog box. 
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The key to making solver work is the solver Parameters dialog box shown below. 
 

  
 

The target cell is set to refer to the total portfolio value at the end of the year because this is 
the value that we want to maximize. The changing cells are set to reference the percentages of 
each investment. Finally the various constraints are expressed as formulas as shown in the 
lower left hand corner of the dialog box. Once solver has been run once, the solver formulas 
stick to the worksheet and the results are changed and updated as the various assumptions in 
the worksheet are changed and updated. For example, you may later determine that the 
growth rate for real estate is a different amount. Inputting that new amount in the worksheet 
will cause Excel to automatically adjust all variables to produce the optimum investment mix 
that maximizes earnings without violating any stated constraints. 

 
Creating a New Worksheet can be a Drag 
 
Q. How can I insert new worksheets in my Excel workbook without having to constantly setup 
new headers and footers in those new worksheets?  
 
A. Excel 2003, 2007 and 2010 allow you to duplicate a worksheet by holding the Ctrl key down 
and dragging the worksheet’s tab to the left or right. This action will insert a new worksheet, 
complete with the same headers, footers, margins, column widths, and cell contents, as the 
original worksheet. (In many situations, this method is quicker and easier than inserting a new 
worksheet and then adding headers, footers, margin settings and content.)   
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Alternative Approach: You can achieve the same results using the menus by selecting a 
worksheet tab (or group of tabs), right-mouse clicking on that worksheet tab (or group of tabs), 
selecting Move or Copy, checking the Create a copy checkbox, and clicking OK. 

 

Hint: You can also use this procedure to duplicate multiple worksheets at the same time. To do 
this, select the first worksheet to be duplicated by clicking on the worksheet tab. Next, while 
holding down the Shift key, select the last worksheet to be duplicated by clicking on its’ tab. 
(This action will select those two tabs, and all worksheet tabs in between.)  Complete the copy 
by holding the Ctrl key down and dragging the group of worksheet tabs to the left or right.  

 

A Refreshing Change in Your Portfolio  
 
Q. I’ve heard that you can create a stock portfolio in Excel that is updated automatically via the 
Internet. Can you please tell me if this true, and if so how this is accomplished? 
 
A. You’ve heard correctly. Excel provides a built-in query tool that can link your worksheet to 
20-minute delayed stock quote information. This query tool uses Open Database Connectivity 
(ODBC) to establish a permanent connection between the source data and your Excel 
workbook. Once the link has been created, your Excel workbook can be updated with current 
stock price information simply by clicking the Refresh button. To build an ODBC-based stock 
portfolio, make sure that your computer is connected to the internet, and create a  basic 
portfolio as suggested in the screen image below: 
 

 
 
Be sure to include valid ticker symbols for each of the stocks, mutual funds, ETFs and other 
investments you own. Next, create the query as follows: 
 

1. Launch the Import Data dialog box as follows: 

 
a. In Excel 2007 and 2010, from the Data Ribbon, select Existing Connections from the Get 

External Data Group. This action will launch the Existing Connections dialog box. In the 
Existing Connections dialog box, select MSN MoneyCentral Investor Stock Quotes. 
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b. In Excel 2003, from the Data Menu select Import External Data, Import Data. This 
action will launch the Select Data Source dialog box. In the Select Data Source dialog 
box, select MSN MoneyCentral Investor Stock Quotes. 
 

2. In the Import Data dialog box, select the option for New worksheet as shown below, and click 
OK to display the Enter Parameter Value dialog box. 
 

 
 

In the Enter Parameter Value dialog box, click the Cell Chooser icon and highlight the cells in 
your portfolio containing the stock ticker symbols as shown below. Check the box labeled Use 
this value/reference for future refreshes and click OK.  

 

 
 

This action will retrieve and display an array of stock quote information from the MSN 
MoneyCentral Investor database in a new Excel worksheet. This information includes the name 
of each investment and 20 minute delayed price per share data, among other information. An 
example of the resulting stock quote query is shown below. 
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Return to your portfolio worksheet and fill in the missing name and stock price information 
using simple reference formulas to refer to the investment names and stock price information 
on the query worksheet. For example, select cell D3 in your portfolio worksheet, and enter the 
formula =QueryWorksheet!D4 (assuming the worksheet containing your query is named 
QueryWorksheet). Thereafter, each time you click the Refresh All button, Excel will update the 
query results, which in turn will update your portfolio.   
 

 
 

Tip 1: If you plan to print your portfolio report, insert the formula =NOW() in cell A1 (or any 
blank cell) to ensure that the date and time your portfolio was printed appears on the report. 
 
Tip 2: If you prefer to use the Refresh button (ie: instead of the Refresh All button), you must 
first select a cell (or cells) within the query.  
 
Tip 3: If you later add more line items to your portfolio, you can change the query parameters 
by right mouse clicking on the query and selecting Parameters from the drop down menu.  
 

 XPS versus PDF 
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Q. I see that Microsoft Office 2007 and 2010 offer a new format called XPS.  I have read that 
this new format supports the paperless environment and I wonder if our firm should be using 
this format as we go paperless. Can you tell me what this is?  
 
A. XPS (XML Paper Specification) is a new format developed by Microsoft that offers an 
alternative to Adobe System’s PDF (Personal Document Format) format. A key advantage of 
both XPS and PDF formats is that the fonts used in the document are embedded in the file so 
that the document will display and print properly on other computers and printers. For Word 
2007 and 2010 users, an advantage of the XPS format is that no additional software is required 
to view the XPS based documents because Microsoft Word automatically views documents 
with the XPS format. However, PDF documents require the user to download a PDF reader, 
such as the Acrobat Reader in order to view the document.  To create an XPS document in 
Word 2007 or 2010, from the Office Start button or File tab, select Save As, and select the XPS 
Document option form the Save as type: drop down box shown below, provide a file name in 
the File name: box, and click OK.   
 

 
 
Be aware that once you have saved a Word document as a PDF or XPS file, it cannot be easily 
edited or converted back to a Microsoft Office file format without specialized software or a 
third-party add-in. Both PDF and XPS file formats are frequently used to produce finalized 
documents to be shared. For example, financial reports, tax returns, legal documents, 
contracts, newsletters, and resumes are examples of documents that are commonly converted 
to PDF or XPS formats prior to sharing.   
 

Excel’s New Slicer - It Slices, it Dices… 
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Q. We maintain a large amount of data for more than 100 restaurants and we analyze sales and 
expenses daily, weekly and monthly by location, city, state and territory, and even by type of 
restaurant. Overnight, the results of operations for the previous day feed into a database and 
we analyze the data in Excel using pivot tables. Despite preparing dozens of reports, my 
superiors desire more detailed reports and analysis. Can you offer a good solution?   
 
A. Excel 2010’s new Slicer may be the answer you are looking for. Slicer is an enhancement to 
Excel 2010’s PivotTables that inserts filter boxes that your superiors can click to display 
precisely the reports they desire. To use Slicer, position your cursor anywhere in a PivotTable 
report and from the Insert ribbon, select Slicer from the Filter group. This action will open the 
Insert Slicers dialog box shown below.  
 

 
 
Place a checkmark in the checkbox for each slicer you want to display and click OK. Excel will 
insert slicer dialog boxes containing filter buttons in the worksheet for each field name you 
select, as shown below. 
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Simply click the various filter buttons to display different views of your data. For example, the 
report below summarizes revenue for those “Dine-In” and “Drive-Thru” restaurants managed 
by “Caroline” and “Madison” in the “Atlantic” and “Great Lakes” regions. (Holding down the 
Ctrl key allows you to make multiple selections within a Slicer dialog box.) The selected filter 
buttons are highlighted and the non-selected filter buttons are greyed out, allowing you to see 
which filters have been applied to the report. 
 

 
 
In the example shown above, the reader could produce up to 720 different views of this one 
report (9 States times 4 Types times 4 Territories times 5 Sales Reps). In your situation, you 
could add three similar PivotTable reports summarizing your data by week, month, and quarter, 
and e-mail the entire workbook to your superiors. This would limit the total number of reports 
you would need to prepare to just four, yet provide your superiors with the ability to view the 
data thousands of different ways, according to their preference.   
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Advanced Tip: A Slicer can be shared with multiple PivotTable reports so that when filters are 
applied in one Slicer, multiple PivotTable reports are filtered. To share a Slicer, click on the 
Slicer to be shared to display the Slicer Tools, Options tab. In the Slicer group, select PivotTable 
Connections and place a checkmark next to the PivotTables you want to share the Slicer as 
shown below.  
 

 
 
Hint: You can resize and re-position your slicers on the worksheet, and apply matching styles to 
both the PivotTables and Slicers to produce professional looking results.  
 

E-Mail a Single Worksheet 
 
Q. What is the easiest way to send a single Excel worksheet to a staff member without sending 
them the entire workbook? 
 
A. You can send a single worksheet (ie: not the entire workbook) from within Excel using the 
integrated Outlook Send this Sheet applet, as follows: 

 

1. Launch the E-Mail dialog box tool as follows: 
 

In Excel 2003 - Select File, Send to Mail Recipient. 

 

In Excel 2007 and 2010 – Right mouse click on the Quick Access Toolbar and select Customize Quick 

Access Toolbar. In the Choose commands from: drop down box, select Commands Not in the 

Ribbon. Scroll down and select Send to Mail Recipient, and click the Add>> button to include this 

command on your Quick Access Toolbar. Click OK. Click the Send to Mail Recipient icon on the 

Quick Access Toolbar.   

 

2. In the E-Mail dialog box, select the radio button labeled Send the current sheet as the message 
body, and click OK.  
 



www.CarltonCollins.com Page 27 Copyright April 2011 
 

 
 

3. This action will create an e-mail message using the worksheet contents as the e-mail message with 
limited Outlook tools and functionality as shown below. Indicate the e-mail recipients and subject as 
you would normally when preparing an E-mail message and click Send the Sheet.   

 

 
 

The Send This Sheet menu is integrated with Outlook so that the To…, Cc…, and Bcc… drop 
down fields will display your contacts and contact groups you maintain in Outlook. Once the e-
mail is sent, a copy of the e-mail appears in your Outlook Sent Items box, similar to that of a 
regular e-mail. 
 
Cautionary Note 1: When using this Send the current sheet as the message body option, the 
Excel data is converted from an Excel format into a table format containing only values. To send 
a single worksheet with the Excel formulas intact, make a copy of the workbook, delete all of 
the worksheets except for the one you intend to send, and repeat the steps above using the 
Send the entire workbook as an attachment option.  
 
Cautionary Note 2: When sending e-mails from within Excel, your default signature block is not 
inserted into the e-mail. 
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Cautionary Note 3: This functionality works well with Outlook, but does not necessarily work 
with other e-mail client applications.  

 
Displaying a Two Digit Year 
 
Q. How can I force Excel to display a two-digit year (instead of a four-digit year) by default?  
 
 
A. Many of Excel’s default settings are determined by the setting in the Windows Regional and 
Language Options. To adjust these settings, launch the Regional and Language Options dialog 
box as follows: 
 

1. In Windows XP, launch Control Panel from the Start Menu, and double click the Regional and 
Language Options icon. 
 

2. In Windows Vista and Windows 7, launch Control Panel from the Start Menu. Select System and 
Maintenance, then in the left hand menu select Clock, Language, and Region, Regional and 
Language Options. 

 
In the Regional and Language Options dialog box, click the Customize this format…to open the 
Customize Regional Options dialog box. On the Date Tab, click the Short date: drop down 
arrow in the Date formats group and select a date format that includes a two-digit date as 
shown below.  

 
 
You must close and restart Excel for this change to take effect. Thereafter, Excel will display the 
two-digit date format you specified as the default. 
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Cautionary Point: It is important to understand that even when you are displaying 2-digit years, 
you should still make it a habit to enter 4-digit years, otherwise Excel may assume the wrong 
century. This is because Excel interprets two-digit years ending in 00 through 29 as years 2000 
through 2029. (For example, if you type the date 6/2/20, Excel assumes the date is June 2, 
2020.) However, Excel interprets two-digit years ending in 30 through 99 as years 1930 through 
1999. (For example, if you type the date 6/2/60, Excel assumes the date is June 2, 1960.) You 
can change the way Excel interprets two-digit years by adjusting the Calendar setting located at 
the bottom of the Customize Regional Options dialog box (shown above).   
 

 

Dating Tips 
Q. When entering dates in Excel, it would be much simpler if I could enter the date as just the 
numbers without the forward slash character – 061010 or 06102010 instead of 06/10/10 or 
06/10/2010. Entering the slash makes the exercise a two-handed exercise instead of one-
handed exercise via the numeric keyboard. Is there a way to enter data into just one cell so I 
can avoid using multiple cells and then concatenating? 
 

A. You can enter dates into Excel 2003, 2007 and 2010 without using slash marks by applying a 
custom format. Start by highlighting the range of cells and right-mouse click on that range to 
display the pop-up menu. Select Format Cells to display the Format Cells dialog box. On the 
Number tab select Custom, and enter the following custom format in the Type box: 
00\/00\/0000, then click OK. (Because the forward slash has special meaning in a custom 
format, you must precede it with a backslash for Excel to recognize the slash mark as a literal 
character, not its special meaning.) Thereafter, dates entered without slash marks will display 
slash marks, and the date will behave like a date instead of text. An example is shown below.  
 

 
Once created, Excel remembers the custom format so you won’t have to create it again in the 
future. 
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Hint: To display dates without the preceding zeros, use this custom format. ##\/##\/##.  

 
Hide Me Quick 
Q. I am constantly hiding, un-hiding and re-hiding columns to generate reports in a multitude of 
report layouts, and I can’t figure out how to display only the hidden column that I need without 
having to display all my hidden columns? Can you help? 
 
A. Because hiding and un-hiding columns is a frequent task for many CPAs, I will address your 
specific question, and then offer a different solution. To unhide a specific column in Excel 2003, 
2007 or 2010, press the F5 key to launch the Go To dialog box and type in any cell address 
within that column (such as G1), and click OK. This will place your cursor within column G, even 
if hidden. Next, type the keyboard shortcut sequence Alt, O, C, U to unhide the column.  
 
Alternatives – There are many alternatives for un-hiding columns, several of which are 
presented below so you can use the approach that work’s best for you. 
 

1. Menu Options - To unhide a column using the menu in Excel 2007 and 2010, from the Home 
tab, select Format from the Cells group, Hide & Unhide, Unhide Columns. To unhide a column 
using the menu in Excel 2003, select Column, Unhide from the Format menu.   

2. The Traditional Unhide Shortcut - In Excel 2003, 2007 and 2010, Windows XP users can unhide a 
column by typing Ctrl + Shift +), but this keystroke combination appears to be inactive in 
Windows Vista and Windows 7.  
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3. Column Width - Instead of un-hiding a column, you could simply increase the column width to 
make it visible. Start by pressing the F5 key to open the Go To dialog box and enter a cell 
address to go to a hidden column. To resize column widths in Excel 2007 and 2010, from the 
Home tab, select Format from the Cells group, Column Width, enter the desired width, and click 
OK. To resize a column width in Excel 2003, from the Format menu select Column, Width, enter 
the desired width, and click OK.  

 
Advanced Hint: To make your task easier, assign a name to a cell in each column you wish to 
hide or unhide using the Name Box (located just above the Column A heading). For example, 
you might assign the name YTD to cell G1, and the name Budget to cell H1. This will make it 
easier for you to use the Go To command because the name makes it obvious which column is 
which, whereas you might have a difficult time remembering which column label is which. 
Further, you could also use the Name Box to assign a name to a group of columns, and use the 
same procedure described above to hide or unhide that group. For example, you might assign 
the name PriorYear to cells J1 thru M1, and use the Go To command to go to those columns 
and unhide the entire lot.  
 
A Better Suggestion - Rather than constantly hiding and un-hiding columns, a better approach 
would be to use the Custom Views feature in Excel 2003, 2007 and 2010. By creating custom 
views, you can easily toggle back and forth between all of your views. To create your first 
custom view, unhide all of your columns and from the View tab (or View menu in Excel 2003), 
select Custom Views. Click the Add button and enter a description in the Name box, then click 
OK. Next, hide various columns in your workbook and repeat these steps to create a second 
view of your data that includes selected hidden columns. Continue to create additional custom 
views for each of your desired hidden column layouts. Thereafter, you can reduce or eliminate 
the need to hide and unhide columns in the future by simply changing the view. To toggle 
between custom views, from the View tab by select Custom Views in the Workbook Views 
group, and double click the desired custom view as shown below. 
 

 
 
   
 

Animate Excel Charts in PowerPoint by Data Series 
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PowerPoint 2010 allows you to animate your charts by data series as follows. Start by creating a 
chart in PowerPoint, or if you prefer, copy and paste a chart from Excel into PowerPoint. Click 
on the chart to select it, and click Animation Pane from the Animations tab to display the 
Animation Pane. Again, with the chart still selected, from the Animation tab, click Add 
Animation and select an Entrance animation such as Bounce, for example.  

 
In the Animation Pane click the drop down arrow next to the animation and click Effect Options 
to open the Bounce dialog box. Next, on the Chart Animation tab, click the Group chart drop-
down arrow and select By Series, and click OK. Thereafter, when you display the slide show, 
each data bar series will bounce in individually, helping your audience identify the specific data 
series you are discussing. The screenshot below depicts the data series for sales representative 
Scott as the bars are bouncing into position. 
 

 
 

Hints: The ability to animate charts by data series first appeared in PowerPoint 2007, 
and the instructions are similar, but not identical to those described above. This feature 
is not available in charts that contain links to other applications, such as Excel.   

 
An Excellent Arrangement 
Q. Last year my office upgraded to two monitors at each workspace.  Having simultaneous full-
screen views of two different files is a vast improvement over split-screen windows.  Is it 
possible to display a different tab from the same Excel worksheet on two monitors? 
 
A. Start by displaying Excel across both monitors as follows: Click the Restore Down button in 
the upper right corner of the Excel window. Use the mouse to drag the edge of the Excel 
window across both monitors.  
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To display two views of the same workbook in Excel 2007 or 2010, select New Window from 
the View menu, then select Arrange All, Tiled, OK also from the View menu. In Excel 2003, 
select New Window from the Window menu, then select Arrange, Tiled, OK also from the 
Window menu. You can view multiple worksheets from the same workbook side-by-side on a 
single monitor. In this situation, each window will scroll independently and best of all, according 
to reader Rick McNeil, updates entered into one window will automatically update the other 
windows. An example of multiple windows for the same workbook is shown below. 
 

 
 

Hint: To ignore other workbooks you have open, and arrange the windows for your current 
workbook only, check the Windows of active workbook checkbox in the Arrange Windows 
dialog box in Excel 2010, or the Arrange All dialog box in Excel 2007. 
 

 



www.CarltonCollins.com Page 34 Copyright April 2011 
 

 

Pasting Away Again… 
 

Q. Often in Excel, I need to copy and paste the account number from one cell location to multiple cell 
locations. However, as soon as I use the Excel menu, the account number data from the source cell is 
deselected, and I must keep going back to recopy the original cell. Is there a trick to pasting contents to 
multiple cells without having to copy it repeatedly? 

 
A. This solution should help. Before you copy the contents of the source cell, click the F2 key to enter 
edit mode. Use your mouse to select the entire contents of the cell, then Right Mouse Click and select 
Copy from the popup menu (or press Ctrl + C). This action will copy the contents of your source cell to 
the Windows Clipboard where it will remain until you copy something else to clipboard. This will allow 
you to continue to paste the contents of the original cell multiple times without losing the source data, 
even if you use the Excel menu.       

 

 
 

Add Value, Instantly 
Opening two Workbooks in one Instance of Excel across Multiple Monitors 
 
Q. When I open Excel on my two separate monitors, Excel doesn’t allow me to use Paste 
Special, Value, Add; it only works when I have the two workbooks opened on the same 
monitor. What’s going on and how do I fix this? 
 
A. The issue is not that you are using two computer monitors, the issue is that you have two 
instances of Excel open at the same time, and Excel’s paste function behaves differently when 
pasting between two instances of Excel compared to pasting between two workbooks opened 
in the same instance of Excel.  
 
Last month’s topic titled “An Excellent Arrangement” provided instructions for displaying two 
views of a single Excel workbook side-by-side on a single monitor. Building on this foundation, 
presented below are similar steps for displaying two different Excel workbooks side-by-side in a 
single instance of Excel stretched acorss two monitors. This approach will enable you to both 
view and use Paste Special, Value, Add between two different workbooks displayed on 
separate monitors.  
 

1. Open only one instance of Excel. 
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2. Restore down the Excel window by double-clicking the Title Bar located at the top of the 
window.  

3. Stretch the window across both monitors by hovering your mouse pointer over either the left or 
right edge of the window until your pointer becomes a double arrow, then click and drag the 
window across both monitors.  

4. Open two Excel workbooks. 
5. In Excel 2007 and 2010, select Arrange All from the View tab to display the two workbooks side-

by-side, each appearing in a sepeate monitor. In Excel 2003, select Arrange from the Window 
menu, select Tiled, and click OK. 

 
You can now use Paste Special, Value, Add between the two Excel workbooks.  
 

Foot Your Financials in Excel 
Attaching Footnotes to Excel-based Financial Statements 
 
Q. We produce financial statements from Excel, but typing the footnotes at the bottom of the 
financial statements is a headache because Excel does not offer word wrap, outlining and other 
word processing features. We have tried using different solutions such as Excel’s Justify 
command, and pasting from Word, but these solutions fall short, especially when edits are 
needed. Is there a better approach? 
 
A. Embedding a Word document in Excel as an object is a solution that provides Word 
processing functionality in Excel. To embed a Word document in an Excel 2003, 2007 or 2010 
worksheet, select Object from the Insert tab or menu, then select Microsoft Word Document 
and click OK. Use the mouse to reposition and resize the resulting embedded Word Document 
Object underneath the financial statement (or in the appropriate position) as pictured below.   
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The embedded Word object allows you to type using the same word processing functionality 
provided by Word, such as outlining, paragraph justification, indenting, and Word shortcuts 
(such as Shift+F3 to change case). When you click away from the Word object, the Word menus 
disappear and the Excel menus return to normal. Double clicking on the Word object 
reactivates the embedded object allowing you to further edit its’ contents using word 
processing functionality. 

 
 
To finalize your footnotes, consider adding the following finishing touches: 
 

1. Font - For consistency, change the footnote font to match the font used in the financial 
statements.  
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2. Border - Click away from the Word box to deactivate the object, and click the Word box once to 
select it. Right-mouse click on the edge of the Word object to display the popup menu, and 
select Format Object as pictured above. On the Colors and Lines tab, click the Line Color drop 
down arrow and select No Line, and click OK.  

 
Once printed, the resulting footnotes will appear seamlessly at the bottom of the financial 
reports, as shown below. 

 

A Colorful Preview  
Make Print Preview Display Charts and Tables in Color 

 
Q. I developed a presentation consisting of numerous Excel charts and data tables on my 
desktop computer, and I plan to use Print Preview to deliver the presentation. In practice, on 
my desktop computer this approach works well; but when I transfer the presentation to my 
laptop, the presentation previews in black and white, not color. I can’t find a setting anywhere 
to make my laptop preview in color. Can you help?  
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A. I applaud your ingenuity; using Print Preview can sometimes be a quick and easy method for 
organizing and displaying selected portions of your Excel worksheet to an audience. Excel’s 
Print Preview uses the system’s default printer as a basis for rendering the preview. If you 
change your computer’s default printer to a color printer, the previewed print job will display in 
color.  
 
To change your default printer setting, launch Control Panel from the Start button, and: 
 

1. In Windows 7, select Hardware and Sound, Devices and Printers, 
2. In Windows Vista, select Hardware and Sound, Printers, 
3. In Windows XP, select Printers and Faxes, 

 

Right click on a color printer, and select Set as default printer from the popup menu as pictured 
below. 

 
You can set up and use a color printer for Print Preview purposes, even if you do not have a 
color printer attached to your laptop computer. To add a color printer:  
 

1. Launch Control Panel and: 

 
a. In Windows 7 and Vista, select Hardware and Sound, Add a printer, 
b. In Windows XP, select Printers and Faxes, and under the Printer Tasks menu, select Add 

a printer, 
 

2. In the Add Printer dialog box, select Add a local printer,  
3. Choose any port from the Use an existing port drop down menu and click Next,  
4. Select any manufacturer and color printer model and click Next,  
5. Provide an appropriate name in the Printer Name box, click Next,  
6. If asked to share the printer, select No, 
7. Click Finish. 

 

  



www.CarltonCollins.com Page 39 Copyright April 2011 
 

One Tall Solution 
Leave the Tall Print Setting Blank when Scaling to Width 
 
Q. When printing large worksheets in Excel 2003, is there an easy trick to figuring out how 
many pages tall the print job needs to be to ensure that my worksheet prints out as wide as 
possible on the page, but no wider? I usually set the page width to 1 page, then use the trial 
and error method to figure out how many pages tall the print job needs to be.  
 
A. Yes, there is an easy solution. Simply leave the tall box blank in Page Setup, and Excel will 
automatically calculate the number of pages tall the report needs to be to print your worksheet 
based on the number of pages wide you specify.  
 

 
 
Note: Excel 2007 and 2010 both provide the menu option Fit All Columns on One Page that 
accomplishes the same result.  
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I Hope to See You Zoom 
 

I use Excel 2003 and I sometimes find it difficult to read the small font in my worksheet. 
To make the worksheet more readable, I use the View, Zoom, 200% option, but I find it 
tedious to switch back and forth from 100% to 200% view. Is there a better approach 

that I am missing? 
 

In Microsoft Excel 2003, 2007 and 2010, you can zoom in and out instantly by holding 
down the Ctrl Key while rolling the wheel on your scrolling mouse. This approach is not 
only faster, but it also allows you to zoom up to a 400% view, down to a 10% view, and 

any option in between. This works in Microsoft Word too.  
 
Microsoft Office 2007 and 2010 now include a new Zoom tool at the bottom right hand corner 
of the screen which accomplishes the same result.  
 

 
 

It’s Time to Split 
 
Q. I have a large Excel worksheet and I need to be able to compare data throughout the 
worksheet. I’ve been using the View, Freeze Panes tool to temporarily freeze rows or columns 
so that I can view and compare data in different parts of the worksheet, but this method 
requires a lot of freezing and unfreezing. Is there a better option? 
 
A. Excel 2003, 2007 and 2010 contain two Split Screen tools which allow you to quickly split the 
Excel worksheet horizontally, vertically, or both. Like the Freeze Pane tool, the split screen tools 
also allow you to view and compare different portions of your data. To use these tools, click 
and drag the split screen tools to the desired positions. The Split Screen tools are located in the 
upper right hand corner and lower right hand corner of the worksheet area, as shown below. 
 

       
 

Q 

A 
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In the example below the Vertical Split Screen tool has been used to display data for the 1st 
quarters of 2009 and 2010. (Notice that the columns jump from column E to column O). 
Additionally, the Horizontal Split Screen tool has been used to fix the column headings at the 
top of the worksheet. (Notice that the row numbers jump from row 3 to row 7.)  

 

 
 

I Command You 
 
Q. Recently, I upgraded to Excel 2007 and I can’t seem to find all of the same commands I used 
in Excel 2003, such as the ability to e-mail a single worksheet or pivot multiple ranges of data. 
Why did Microsoft get rid of some of Excel 2003’s commands and are there any good work-
around procedures for these missing capabilities? 
 
A. The missing functionality you mention is still there in Excel 2007 and 2010, but it is hidden. 
When Microsoft redesigned the menus for Excel 2007 and 2010, they excluded 219 commands 
from the newer menu ribbon. To view a complete list of these hidden commands follow these 
steps: Start by right-mouse clicking on the Quick Access Toolbar and choosing the option to 
Customize Quick Access Toolbar.  
 

 
 
Next, in the Choose commands from drop down box, select the option to view Commands Not 
in the Ribbon.  
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This action will display the list of 219 commands not included in the ribbon on the left side of 
the dialog box, and those commands that are included in your Quick Access Toolbar on the right 
side of the dialog box.  
 

 
 
To access these hidden commands, you must first add them to your Quick Access Toolbar by 
highlighting the desired command in the left column, and clicking the Add>> button to include 
it in the right column. Most of the hidden tools are obscure and seldom used, however some of 
them are among my favorites. The seven Excel 2003 commands that are most notably missing 
from the Excel 2007 and 2010 menu ribbon are shown below. 
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While the particular commands you choose to add to your 
Quick Access Toolbar will depend on personal preference, I 
recommend that you add the above mentioned commands 
to your Quick Access Toolbar, as well as the following 
twenty additional commands (shown to the right) which I 
personally find more useful, to make them easily 
assessable. 
 

 
 
 
 
 
Note: There are a few Excel 2003 capabilities that have disappeared from Excel 2007 and 2010. 
For example: 
 

1. You can no longer publish web pages in an interactive format (The interactive format 
command in Excel 2003 allows you to publish HTML pages in which readers can input data 
directly via their browser).  
 

2. Embedded video clips and sound clips no longer play as embedded objects in Excel 2007 and 
2010; instead those clips are played in your computer’s default media player application.  

 

3. There is no longer an auto format option which automatically highlights your subtotal rows.  
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XML Data 
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Overview of XML in Excel 
Microsoft Office Excel makes it easy to import Extensible Markup Language (XML) (Extensible Markup 
Language (XML): A condensed form of Standard Generalized Markup Language (SGML) that enables 
developers to create customized tags that offer flexibility in organizing and presenting information.) 
data that is created from other databases and applications, to map XML elements from an XML 
schema (XML Schema: A formal specification, written in XML, that defines the structure of an XML 
document, including element names and rich data types, which elements can appear in combination, 
and which attributes are available for each element.) to worksheet cells, and to export revised XML data 
for interaction with other databases and applications. Think of these XML features as turning Office 
Excel into an XML data file generator with a familiar user interface. 

 
1. Why use XML in Excel?  

a. XML data and schema files  
b. Key XML and Excel scenarios  

2. The basic process of using XML data in Excel  
a. Working with XML maps  
b. Using the XML Source task pane  
c. Element types and their icons  
d. Working with single-mapped cells  
e. Working with repeating cells in XML tables  
f. XML map security considerations  
g. Importing XML data  
h. Working with an inferred schema  
i. Exporting XML data  

3. Using the Excel macro-enabled Office XML Format file  

 

Why use XML in Excel? 
XML is a technology that is designed for managing and sharing structured data in a human-readable text 
file. XML follows industry-standard guidelines and can be processed by a variety of databases and 
applications. Using XML, application designers can create their own customized tags, data structures, 
and schemas. In short, XML greatly eases the definition, transmission, validation, and interpretation of 
data between databases, applications, and organizations. 
 

XML data and schema files 
Excel works primarily with two types of XML files: XML data files (.xml), which contain the custom tags 
and structured data. Schema files (.xsd), which contain schema tags that enforce rules, such as data type 

and validation.  Note   The XML standard also defines Extensible Stylesheet Language Transformation 

(XSLT) (XSL Transformation (XSLT): A file that is used to transform XML documents into other types of 
documents, such as HTML or XML. It is designed for use as part of XSL.) (.xslt) files, which are used to 
apply styles and transform XML data into different presentation formats. You can apply these 
transforms before you import XML files into Excel and after you export XML files from Excel. If XSLT files 
are linked to XML data files that you import into Excel, you do have the option to apply or not apply the 
formatting before the data is added to the worksheet, but only when you open an XML file by using the 
Open command on the Microsoft Office Button . 
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Key XML and Excel scenarios 
By using XML and Excel, you can manage workbooks and data in ways that were previously impossible 
or very difficult. By using XML maps, you can easily add, identify, and extract specific pieces of business 
data from Excel documents. For example, an invoice that contains the name and address of a customer 
or a report that contains last quarter's financial results are no longer just static reports. You can easily 
import this information from databases and applications, revise it, and export it to the same or other 
databases and applications. The following are key scenarios that the XML features are designed to 
address: 
 

1. Extend the functionality of existing Excel templates by mapping XML elements onto existing 
cells. This makes it easier to get XML data into and out of your templates without having to 
redesign them.  

2. Use XML data as input to your existing calculation models by mapping XML elements onto 
existing worksheets.  

3. Import XML data files into a new workbook.  

4. Import XML data from a Web service into your Excel worksheet.  

5. Export data in mapped cells to XML data files independent from other data in the workbook.  
 

The basic process of using XML data in Excel 
The following diagram shows how the different files and operations work together when you use XML 
with Excel. Essentially, there are five phases to the process: 

 

 
1. Adding an XML schema file (.xsd) to a workbook  

2. Mapping XML schema elements to individual cells or XML tables  

3. Importing an XML data file (.xml) and binding the XML elements to mapped cells  

4. Entering data, moving mapped cells, and leveraging Excel functionality, while preserving XML 
structure and definitions  

5. Exporting revised data from mapped cells to an XML data file  

6.  
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Working with XML maps 
You can create or open a workbook in Excel, attach an XML schema file (.xsd) to the workbook, and then 
use the XML Source task pane to map XML elements of the schema to individual cells or tables. After 
you map the XML elements to your worksheet, you can import and export XML data into and out of the 
mapped cells. When you add an XML schema file (.xsd) to your workbook, you create an XML map. In 
general, XML maps are used to create mapped cells and to manage the relationship between mapped 
cells and individual elements in the XML schema. In addition, these XML maps are used to bind the 
contents of mapped cells to elements in the schema when you import or export XML data files (.xml). 
 
There are two kinds of mapped cells that you can create: single-mapped cells and repeating cells (which 
appear as XML tables). To make designing your worksheet more flexible, you can drag the mapped cells 
anywhere on a worksheet and into any order — even one different from the XML schema. You can also 
choose which elements to map and not map. 

 
The following rules about using XML maps are important to know: 

1. A workbook can contain one or more XML maps.  

2. You can only map one element to one location in a workbook at a time.  

3. Each XML map is an independent entity, even if multiple XML maps in the same workbook refer 
to the same schema.  

4. An XML map can only contain one root element. If you add a schema that defines more than 
one root element, you are prompted to choose the root element to use for the new XML map.  

 

Using the XML Source task pane 
You use the XML Source task pane to manage XML maps. To open it, on the Developer tab, in the XML 
group, click Source. The following diagram shows the main features of this task pane. 

 

 
 

1. Lists XML maps that were added to the workbook 
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2. Displays a hierarchical list of XML elements in the currently listed XML map 

3. Sets options when working with the XML Source task pane and the XML data, such as how to 
preview the data and control headings 

4. Opens the XML Maps dialog box, which you can use to add, delete, or rename XML maps 

5. Verifies whether you can export XML data through the current XML map 

 
 

Element types and their icons 
The following table summarizes each type of XML element that Excel can work with and the icon that is 
used to represent each type of element. 
 

Element type Icon 

Parent element   

Required parent element   

Repeating parent element  

Required repeating parent element   

Child element   

Required child element  

Repeating child element  

Required repeating child element  

Attribute  

Required attribute  

Simple content in a complex structure  

Required simple content in a complex structure  
 
Working with single-mapped cells 
A single-mapped cell is a cell that has been mapped to a nonrepeating XML element. You create a single-
mapped cell by dragging a nonrepeating XML element from the XML Source task pane onto a single cell 
in your worksheet. When you drag a nonrepeating XML element onto the worksheet, you can use a 
smart tag to choose to include the XML element name as a heading above or just to the left of the 
single-mapped cell, or you can use an existing cell value as a heading. You can also use a formula in a 
single-mapped cell, if the cell is mapped to an XML element with an XML Schema Definition (XSD) data 
type that Excel interprets as a number, date, or time. 
 
  



www.CarltonCollins.com Page 49 Copyright April 2011 
 

Working with repeating cells in XML tables 
XML tables are similar in appearance and functionality to Excel tables. An XML table is an Excel table 
that has been mapped to one or more XML repeating elements. Each column in the XML table 
represents an XML element. An XML table is created when you: 
 

1. Use the Import command (in the XML group on the Developer tab) to import an XML data file.  

2. Use the Open command (on the Microsoft Office Button ) to open an XML data file — and then 
select As an XML table in the Open XML dialog box.  

3. Use the From XML Data Import command (from the From Other Sources command button, in 
the Get External Data group, on the Data tab) to import an XML data file — and then select XML 
table in existing worksheet or New worksheet in the Import Data dialog box.  

4. Drag one or more repeating elements from the XML Source task pane to a worksheet.  

5. When you create an XML table, the XML element names are automatically used as column 
headings. You can change these to any column headings that you want. However, the original 
XML element names are always used when you export data from the mapped cells. 

 
Two options under the Options button in the XML Source task pane are useful when you work with XML 
tables: 

1. Automatically Merge Elements When Mapping  When selected, Excel creates one XML table 
from multiple fields as they are dropped onto the worksheet. This option works as long as the 
multiple fields are dropped on the same row, one adjacent to the other. When this option is 
cleared, each element appears as its own XML table.  

2. My Data Has Headings  When selected, existing heading data is used as column headings for 
repeating elements that you map to your worksheet. When this option is cleared, the XML 
element names are used as column headings.  

 
Using XML tables, you can easily import, export, sort, filter, and print data based on an XML data source. 
However, XML tables do have some limitations regarding how they can be arranged on the worksheet. 

 XML tables are row-based, meaning that they grow from the header row down. You cannot add new 
entries above existing rows. You cannot transpose an XML table so that new entries will be added to the 
right. You can use formulas in columns that are mapped to XML elements with an XML Schema 
Definition (XSD) data type that Excel interprets as a number, date, or time. Just as in an Excel table, 
formulas in an XML table are filled down the column when new rows are added to the table. 
 
XML map security considerations 
An XML map and its data source information are saved with the Excel workbook, not a specific 
worksheet. A malicious user can view this map information by using a Microsoft Visual Basic for 
Applications (VBA) macro. Furthermore, if you save your workbook as a macro-enabled Excel Open XML 
Format File, this map information can be viewed through Microsoft Notepad or through another text-
editing program. 
 
If you want to keep using the map information but remove the potentially sensitive data source 
information, you can delete the data source definition of the XML schema from the workbook, but still 
export the XML data, by clearing the Save data source definition in workbook check box in the XML 
Map Properties dialog box, which is available from the Map Properties command in the XML group on 
the Developer tab. 
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If you delete a worksheet before you delete a map, the map information about the data sources, and 
possibly other sensitive information, is still saved in the workbook. If you are updating the workbook to 
remove sensitive information, make sure that you delete the XML map before you delete the worksheet, 
so that the map information is permanently removed from the workbook. 
 
Importing XML data 
You can import XML data into an existing XML map in your workbook. When you import data, you bind 
the data from the file to an XML map that is stored in your workbook. This means that each data 
element in the XML data file has a corresponding element, in the XML schema, that you mapped from 
an XML Schema file or inferred schema. Each XML map can only have one XML data binding, and an XML 
data binding is bound to all of the mappings that were created from a single XML map. You can display 
the XML Map Properties dialog box (Click Map Properties in the XML group on the Developer tab.), 
which has three options, all selected by default, that you can set or clear to control the behavior of an 
XML data binding: 
 

1. Validate data against schema for import and export  Specifies whether Excel validates data 
against the XML map when importing data. Click this option when you want to ensure that the 
XML data that you import conforms to the XML schema.  

2. Overwrite existing data with new data  Specifies whether data is overwritten when you import 
data. Click this option when you want to replace the current data with new data, for example, 
when up-to-date data is contained in the new XML data file.  

3. Append new data to existing XML tables  Specifies whether the contents of the data source are 
appended to the existing data on the worksheet. Click this option, for example, when you are 
consolidating data from several similar XML data files into an XML table, or you do not want to 
overwrite the contents of a cell that contains a function.  

 
When you import XML data, you may want to overwrite some mapped cells but not others. For 
example, some mapped cells may contain formulas and you don't want to overwrite the formula when 
you import an XML file. There are two approaches that you can take: 
 

1. Unmap the elements that you don't want overwritten, before you import the XML data. After 
you import the XML data, you can remap the XML element to the cells containing the formulas, 
so that you can export the results of the formulas to the XML data file.  

2. Create two XML maps from the same XML schema. Use one XML map for importing the XML 
data. In this "Import" XML map, don't map elements to the cells that contain formulas or other 
data that you don't want overwritten. Use another XML map for exporting the data. In this 
"Export" XML map, map the elements that you want to export to an XML file.  

 
The ability to import XML data from a Web service by using a Data Retrieval Service Connection (.uxdc) 
file to connect to a data source is no longer supported in Microsoft Office Excel 2007 through the user 
interface. If you open a workbook that was created in Office Excel 2003, you can still view the data, but 
you cannot edit or refresh the source data. 
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Working with an inferred schema 
If you import XML data without first adding a corresponding XML schema to create an XML map, Excel 
tries to infer a schema for you based on the tags that are defined in the XML data file. The inferred 
schema is stored with the workbook, and the inferred schema allows you to work with XML data if an 
XML schema file isn't associated with the workbook. When you work with imported XML data that has 
an inferred schema, you can also customize the XML Source task pane. Select the Preview Data in Task 
Pane option from the Options button to display the first row of data as sample data in the element list, 
if you imported XML data associated with the XML map in the current session of Excel. 
 
You cannot export the Excel inferred schema as a separate XML schema data file (.xsd). Although there 
are XML schema editors and other methods for creating an XML schema file, you may not have 
convenient access to them or know how to use them. As an alternative, you can use the Excel 2003 XML 
Tools Add-in Version 1.1, which can create a schema file from an XML map. For more information, see 
Using the Excel 2003 XML Tools Add-in Version 1.1. 
 
Exporting XML data 
You export XML data by exporting the contents of mapped cells on the worksheet. When you export 
data, Excel applies the following rules to determine what data to save and how to save it: 
 

1. Empty items are not created when blank cells exist for an optional element, but empty items are 
created when blank cells exist for a required element.  

2. Unicode Transformation Format-8 (UTF-8) encoding is used to write the data.  

3. All namespaces are defined in the Root XML element.  

4. Excel overwrites existing namespace prefixes. The default namespace is assigned a prefix of ns0. 
Successive namespaces are designated ns1, ns2 to ns<count> where <count> is the number of 
namespaces written to the XML file.  

5. Comment nodes are not preserved.  

6. You can display the XML Map Properties dialog box (Click Map Properties in the XML group on 
the Developer tab.) and then use the Validate data against schema for import and export 
option (active by default) to specify whether Excel validates data against the XML map when 
exporting data. Click this option when you want to ensure that the XML data you export 
conforms to the XML schema. 

 
Using the Excel Macro-enabled Office XML Format File 
You can save an Excel workbook in a variety of file formats, including the Excel macro-enabled Office 
XML Format File (.xlsm). Excel has a defined XML schema that defines the contents of an Excel 
workbook, including XML tags that store all workbook information, such as data and properties, and 
define the overall structure of the workbook. Custom applications can use this Excel macro-enabled 
Office XML Format File. For example, developers may want to create a custom application to search for 
data in multiple workbooks that are saved in the this format and create a reporting system based on the 
data found. 

 
  

http://office.microsoft.com/search/redir.aspx?AssetID=XT011894931033&CTT=5&Origin=HA102063961033
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Bio for J. Carlton Collins, CPA 
ASA Research   Carlton@ASAResearch.com   770.842.5902 

 

J. Carlton Collins, CPA is a Certified Public Accountant with experience in technology, 
tax, auditing, accounting systems, financial reporting, and bond financing. He is an 
author, lecturer, and technology & accounting systems consultant. He has published 
books, articles, and web pages and is the author of the monthly technology Q&A 
column for the Journal of Accountancy. As a public speaker, Mr. Collins has delivered 
more than 2,000 lectures in 44 states and 5 countries addressing more than 500,000 
CPAs and business professionals. As a consultant, Mr. Collins has assisted 275+ large 

and small companies with the selection and implementation of accounting systems. Mr. Collins has a Bachelor’s 
degree in Accounting from the University of Georgia, is a 25+ year member of the American Institute of CPAs and 
the Georgia Society of CPAs, and is also a licensed realtor. 
  
Summary of Selected Positions, Awards & Accomplishments:  
  

1.   Honored as one of the CPA Industries Top 25 Thought Leaders by CPA Technology Advisor Magazine 

2.   Author of the monthly Technology Q&A column for the Journal of Accountancy. 
3.   Recipient of the AICPA’s Lifetime Technical Contribution to the CPA Profession Award.  
4.   Chairman of the Southeast Accounting Show - the South’s largest CPA event. 
5.   Recipient of the Tom Radcliff Outstanding Discussion Leader Award.  
6.   Named “Top Ten CPA Technologists” by Accounting Technologies Magazine (multiple years). 
7.   Named “Top 100 Most Influential CPAs ” by Accounting Technologies Magazine (multiple years). 
8.   Has personally delivered over 2,000 technology lectures around the world. 
9.   Recipient of the Outstanding Discussion Leader Award from the Georgia Society of CPAs.  
10. Lead author for PPC's Guide to Installing Microcomputer Accounting Systems.   
11. Has installed accounting systems for more than 200 companies. 
12. Chairperson of the AICPA Technology Conference.  
13. Recipient of the ACCPAC Partner of the Year Award. 
14. Determined by SAP to be one of the country's "Top Ten Most Influential ERP Systems Consultants". 
15. Has delivered keynote and session lectures at dozens of accounting software conferences. 
16. Sworn in as a Certified Public Accountant on September 18, 1985. 
17. Member of the American Institute of CPAs since 1985. 
18. Member of the Georgia Society of CPAs since 1982. 

  
 As an auditor, Mr. Collins has audited businesses in the areas of health care, construction, distribution, automobile 
dealerships, insurance, manufacturing, and general business.  Mr. Collins' tax experience includes corporate, 
individual, partnership, fiduciary, and estate tax planning work.  In the area of finance, Mr. Collins has prepared (or 
assisted in preparing) feasibility studies and financial forecasts for nearly 300 projects seeking more than $3 billion 
in startup capital. Mr. Collins is familiar with bond issues, Medicare and Medicaid reimbursement, and 
conventional financing matters. In 1992, Mr. Collins contributed and demonstrated more than 500 pages of 
suggested design improvements to the Microsoft Excel development team of programmers - and many of those 
improvements are found in Excel today. 
 
At the University of Georgia, Mr. Collins was elected President of the Phi Eta Sigma Honor Society, was initiated 
into the BIFTAD Honor Society, served three years in the Judicial Defender/Advocate program, and was a member 
of Alpha Tau Omega fraternity. At Glynn Academy High School, Mr. Collins was Senior Class President, Class 
Valedictorian (1 of 6), and received a principle nomination to Annapolis Naval Academy. Mr. Collins has been 
married for 27 years and has two children. He devotes his leisure time to family, travel, tennis, fishing, snow skiing, 
and riding motorcycles (both dirt and street). Mr. Collins is president of his homeowners association, participates 
in the Gwinnett Clean and Beautiful program, and volunteers for Cooperative Ministries food drive. 
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Because I had an extra page left in this book, I’ll throw in a few jokes and quotes to brighten 
your day. Enjoy! 
 
 I’m so poor I can’t even pay attention 

 I have enough money to last me the rest of my life...unless I buy something. 

 It's so simple to be wise. Just think of something stupid to say and then don't say it! 

 I'm searching for fun and happiness that does not involve food or money... 

 We make a living by what we get, we make a life by what we give. 

 Count your age with friends but not with years. 

 Never play leapfrog with a unicorn. 

 Friction can be a drag. 

 When I want your opinion, I'll remove the duct tape. 

 Light travels faster than sound. That's why some people appear bright until you hear them speak. 

 Football is a combination of two of America’s worst elements: Violence and committee meetings. 

 I haven't spoken to my wife in years; I don't like to interrupt her. 

 My fake plants died because I did not pretend to water them 

 Never let a computer know you're in a hurry. 

 I totally take back all those times I didn't want to nap when I was younger. 

 I planned to surprise my wife with a new centerpiece for the table...but the taxidermist was closed. 

 I have kleptomania, but when it gets bad, I take something for it. 

 For every action, there is an equal and opposite government program.  

 Even free advice costs more than it used to. 

 Love is holding hands in the street. Marriage is holding arguments in the street. 

 I always try to hold hands with my wife...because if I let go she'll start shopping! 

 My back goes out more than I do. 

 An Adult is a person who has stopped growing at both ends and is now growing in the middle. 

 The journey of a thousand miles ... begins with a broken fan belt. 

 I'm getting serious about exercising - I've moved my TV set much farther away from my refrigerator. 

 A Freudian slip is when you say one thing but mean your mother. 

 While in the army, Will never liked the phrase "Fire at will". 

 Studies have shown that you can live longer by having more birthdays. 

 My wife keeps saying that I don’t listen to her...or something like that. 

 My life goal is to be filthy stinking rich...well, 2 out of 3 ain't bad. 

 A child of five would understand this. Send someone to fetch a child of five. 

 Warning: Dates in Calendar are closer than they appear. 

 Because of these hard economic times, I have started selling furniture on the side. The trouble is, it 
is my own. 

 
 

Carlton’s CPE Prayer 
Now I lay me back to sleep. 

The speaker's dull; the subject's deep. 
If he should stop before I wake, 

Give me a nudge for goodness' sake. 


